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RBioplot is an R pipeline designed for comprehensive statistical analysis and data visualization, it 
represents a fully automated and versatile data processing solution for molecular biology and 
biochemistry. We need to break free from the confinements of SigmaPlot 12 and Jing Zhang PhD has 
developed a new statistical and graphing R package for molecular biology that is here to help us do just 
that. RBioplot is a black box that will do all our graphing, plotting, and statistical analyses for us with 
minimal data reorganization, time, and energy. This techbull is the RBioplot for dummies user’s manual.  
 
*Note: This techbull will refer you to various websites and to the RBioplot webpage that is hosted on 
our lab website (http://kenstoreylab.com/?page_id=2448). There, you can find all the sample input and 
output files used to make this techbull.  
 
Before using RBioplot you should read the following paper that explains all the functions, commands, 
and options. Also, **when using this program remember to cite**: 
 

Zhang J, Storey KB. (2016) RBioplot: an easy-to-use R pipeline for automated statistical analysis and 
data visualization in molecular biology and biochemistry. PeerJ 4:e2436. 

 

 
 
 
  

http://kenstoreylab.com/?page_id=2448
https://peerj.com/articles/2436/


I. Installing R and RStudio 
To run RBioplot you must first install R on your computer, then install RStudio the user interface for R. 
Links to both of these programs are on the lab website (www.kensotreylab.com) → Research → 
Research Tools → RBioplot (http://kenstoreylab.com/?page_id=2448).  
 

A. Installing “R” 
1) To install ‘R’ visit (https://www.r-project.org) and then select your CRAN preferred CRAN mirror, we 

will use the University of Toronto’s (http://cran.utstat.utoronto.ca/).  
2) Download the version of R that corresponds with your operating system. For example, if you are 

working on a Windows computer click Download R for Windows  → install R for the first time → 
Download R 3.3.1 for Windows 

3) Save the installation .exe file → open the file → follow the R for Windows 3.3.1 Setup Wizard’s 
simple installation instructions.  
*Note: You should install all the installation components and make sure to accept the default 

start-up options.  
 

B. Installing RStudio 
1) To install RStudio visit (https://www.rstudio.com/). Click RStudio → Desktop → Download RStudio 

Desktop  
2) Download the RStudio version that corresponds with your operating system. For example, if you are 

working on a Windows computer click RStudio 0.99.903 - Windows Vista/7/8/10 
3) Save the installation .exe file → open the file → follow the RStudio Setup Wizard’s simple 

installation instructions.  
*Note: Once the program has installed you should locate your RStudio shortcut and place it on 

your desktop.  
 
 

II. Setting up RBioplot  
Open the RStudio application, this will be the platform you will use to run RBIoplot. The picture below is 
a breakdown of the different RStudio quadrants and panels. RStudio is case-sensitive.  

 
  

R Script text editor 

Environment 

Files, Plots, Packages R Console 

!HELP! Home to 

ALL the RBioplot 

help pages 
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1) To setup the R Script text editor go to File → New File → R Script. The text editor is where you should 
prepare your R script before running your commands in the console. The text editor also allows you 
to run multiple commands at the same time (as long as you highlight all the commands you want to 
run).  

2) To use the latest version of RBioplot we need to first install devtools, this package contains some of 
the various dependencies that RBioplot needs to run. This is a one-time installation, to install 
‘devtools’ rewrite the command below in the text editor.  
install.packages(“devtools”) 

 
*Note: You must be connected to the internet. You should rewrite all the commands written in this 

techbull and not just copy them into the text editor. Microsoft word has altered the formatting 
and syntax of these codes and if you copy/paste this into RStudio, your command will not run 
as R Script has unique quotation marks. If you copy/paste then make sure you rewrite your 
quotation marks.  

3) To run your R commands, you have two options: 
a. R Script text editor, (preferred): Highlight the command you want to run and press Ctrl+Enter. 

Or place your text cursor on the command you want to run and press Ctrl+Enter. If you 
separate your command into different lines then make sure all the different commands are 
highlighted and that they can   

b. Console: Copy your command from your text editor to the Console and press Enter. 
4) Once your command has been successfully installed you should receive a message that reads 

something like this:  
 The downloaded binary packages are in  
 C:\Users\Hanane\AppData\Local\Temp\Rtmp4gUWDW\downloaded_packages 

5) Now you are ready to install the RBioplot package. Run the following command: 
devtools::install_github(“jzhangc/git_R_STATS_KBS/package/RBioplot”) 

 
6) You may run into a few errors as the current version of devtools does not contain all the 

dependencies that RBioplot needs, which means you need to manually install the missing packages. 
 
Here are a few examples of errors and solutions, in this first one I was missing the scales package so I 

installed it manually: 
 

Error in loadNamespace(i, c(lib.loc, .libPaths()), versionCheck = vI[[i]]) 
: there is no package called 'scales' 

install.packages("scales") 

 
After I installed the missing package (scales) I re-ran the RBioplot installation command in step 5.  
 

Error in loadNamespace(j <- i[[1L]], c(lib.loc, .libPaths()), versionCheck 
= vI[[j]]) : there is no package called 'sandwich' 

 
Now, I am missing the package (sandwich), so I installed it with the command below and then re-ran 

the RBioplot installation command from step 5. Repeat this process until you have installed all the 
missing packages. 

install.packages("sandwich") 
 

Once RBioplot has successfully been installed you will get this message: 
   * DONE (RBioplot) 
 

7) The next step is to setup your working directory, this is where you will place all your input data files 
and where all your plots, stats, and graphs will be exported to. In this example my working 



directory file is on my desktop and it’s called “RBioplot stuffs”. To setup your working directory run 
the following command and replace “C:\Users\Hanane\Desktop” with your folder address:  

          For Windows:   setwd("C:\\Users\\Hanane\\Desktop\\RBioplot stuffs") 
            For Mac and Linux:   setwd("C:\Users\Hanane\Desktop\RBioplot stuffs") 
 
8) In the ‘Files, Plots, and Packages’ quadrant of the graph you should select ‘Packages’ and then find 

RBioplot in the list. Once you click on RBioplot you will be redirected to a page with the RBioplot 
documentation and all the help files for the different functions. If you get stuck using one of the 
commands use these help files to trouble shoot.  

9) If your RBioplot stops working or there is an error that you have spent the last 3 weeks 
troubleshooting, then you should email the developer jzhangcad@gmail.com and beg for help. 

 

III. RBiostats – “that p-value?” 
Before starting you should visit the rbiostats help page (or the rbiostats mini-HELP! box on page 5), this 
will outline all the available functions and how they work. All sample files used and generated can be 
downloaded from the website. rbiostats is a simple to use function for comprehensive statistical 
analyses that generates a statistical report for various statistical test including: t-tests, ANOVA, Tukey, 
and Dunnett. Make sure to read up on the various tests and to ensure you are using the one most 
appropriate for your data set and experimental design.  
 
1) Your data must be formatted in a very specific 

manner to ensure the values are analyzed 
properly by RBioplot. All excel files MUST be 
saved as a Microsoft Excel Comma Separated 
Values File (.csv) 

2) The table on the right is my Sample Proteins.csv 
file, standardized western blot relative protein 
abundances. The values are normalized with 
coomassie blue loading dye. Experimental 
conditions are listed in the first column. The A1 
cell should read ‘Condition’ – or something 
similar. Protein names are 
listed in the first row. The 
values I report are an 
average of the relative protein 
abundance for all my technical replicates that 
correspond to each of my biological replicates.  
 
*Note: You can analyze and graph your data even with missing outliers in your table.  
*Note: Even though I ran 4 different biological replicates for each experimental condition (ie. 

Control 1, 2, 3, and 4) I have to keep the exact same identifier for each condition or the 
program will separate them into different conditions. 

 
3) To statistically analyze your data using rbiostats, run the following command and replace “Sample 

Proteins.csv” with your “file name.csv” and select the stats test you need. (ANOVA is the default) 
RBioplot::rbiostats("Sample Proteins.csv", Tp = "ANOVA") 

Protein Names 

Experimental 

Conditions 

mailto:jzhangcad@gmail.com


 4) As you are typing your command you will 
notice that RStudio has an auto-fill setting 
that you will find quite useful. If you hover 
your mouse over one of the options that 
appear, you will get a description of the 
function and the various arguments and 
customizations available. 

 
 
 
 
 
7) Outputs a stats.txt file with Shapiro-Wilk normality test results 

and the results of the statistical analysis of interest, this is 
automatically exported to your working directory. In this case, 
my file (on the left) was called Sample Proteins.stats.txt, the 
complete report can be downloaded from the website. For a 
detailed break-down of the statistical report refer to Zhang and 
Storey (2016). Value 

 
 

 
 

IV. RBioplot – “that graph?”  
After analyzing your statistical report, you can now graph your data. RBioplot allows you to generate 
Histograms and is excellent for applications such as western blotting, protein abundance levels, 
transcription factor-DNA binding activity, miRNA expression analyses, mRNA abundance, and many 
others. All sample files used and generated can be downloaded from the website.  
*Note: You will find that the *Notes in this techbull will be useful for all the applications, not just the 

one it is listed in.  
 

A. Histogram: (rbioplot) 
rbioplot is a simple to use function for plotting baseding on the statistical analysis of choice. Before 
starting visit the rbioplot help page, this will outline the different functions and arguments and how to 
properly use them. You can also use the rbioplot mini-HELP! box on page 7.  
 

rbiostats   mini-HELP! 
Usage 
rbiostats(fileName, Tp = "ANOVA") 

 

Arguments 
fileName Input file name. Case sensitive and be sure to type with quotation marks. Currently 

only takes .csv files. 

Tp Type of the intended statistical test. Case sensitive and type with quotation marks. 
Options are: "t-test", "ANOVA", "Tukey" and "Dunnett". Default is "ANOVA".  

 



1) For this example I used the western blotting data set from Sample Proteins.csv (check out rbiostats, 
step1). The protein abundance, PCR quantification, activity levels, etc. should all be in this format 
for rbioplot.  

 
2) To generate a histogram run the following rbioplot command:  

RBioplot::rbioplot("Sample Proteins.csv", Tp = "Tukey", Title = NULL, 
errorbar = "SEM", errorbarWidth = 0.2, fontType = "sans", xLabel = NULL, 
xTickLblSize = 10, xTickItalic = FALSE, xAngle = 0, xAlign = 0.5, yLabel = 
NULL, yTickLblSize = 10, yTickItalic = FALSE, legendTtl = FALSE, plotWidth 
= 170, plotHeight = 150, y_custom_tick_range = FALSE, y_lower_limit = 0, 
y_upper_limit, y_major_tick_range, y_n_minor_ticks = 4) 
 

3) The above command is very versatile and should be tailored to your specific dataset. You can use the 
customizable arguments to design what your graph looks like. Some of the customizable options 
include: Type of statistical test, Title, error bars, font, axes labels, Y-axis ticks, and plot height and 
width. For more information about the individual arguments go to the help pages described above. 

 
4) Once you run the command, a preview of your 

graph will appear in the lower right quadrant 
of RStudio. A pdf version of your graph (600 
dpi resolution.) will also be automatically 
exported into your working directory. In this 
example the pdf generated was titled 
Sample Proteins.plot.pdf.  

 
*Note: If you re-run the above command 
using the same input file name then the new 
generated graph will overwrite your old 
graph.  
*Note: Make sure the .pdf and .plot.pdf file 
that were generated are closed before re-
running. You cannot generate a new file with 
the exact same name if the old version is 
active.  
 
 

5) The above command also outputs a .csv file 
with detailed metrics for the plot, including 
Mean, SEM and significance labels. In this 
sample the exporeted file was named 
Sample Proteins.plot.csv: 

 
  



  

rbioplot   mini-HELP! 
Usage 
rbioplot(fileName, Tp = "Tukey", Title = NULL, errorbar = "SEM", 

  errorbarWidth = 0.2, fontType = "sans", xLabel = NULL, 

  xTickLblSize = 10, xTickItalic = FALSE, xAngle = 0, xAlign = 0.5, 

  yLabel = NULL, yTickLblSize = 10, yTickItalic = FALSE, 

  legendTtl = FALSE, plotWidth = 170, plotHeight = 150, 

  y_custom_tick_range = FALSE, y_lower_limit = 0, y_upper_limit, 

  y_major_tick_range, y_n_minor_ticks = 4) 

 

Arguments 
fileName Input file name. Case sensitive and be sure to type with quotation marks. Currently only 

takes .csv files. 

Tp Type of the intended statistical test. Case sensitive and be sure to type with quotation 
marks. Options are: "t-test", "Tukey" and "Dunnett". Default is "Tukey". 

Title The displayed title on top of the plot. Be sure to type with quotation marks. Default is NULL. 

errorbar Set the type of errorbar. Options are standard error of mean ("SEM"), or standard deviation 

("SD"). Default is "SEM". 

errorbarWidth Set the width for errorbar. Default is 0.2. 

fontType The type of font in the figure. Default is "sans". For all options please refer to R font table, 
which is avaiable on the website: http://kenstoreylab.com/?page_id=2448. 

xLabel x axis label. Type with quotation marks. Default is NULL. 

xTickLblSize Font size of x axis ticks. Default is 10. 

xTickItalic Set x axis tick font to italic. Default is FALSE. 

xAngle The rotation angle (degrees) of the x axis marks. Default is 0 - horizontal. 

xAlign The alignment type of the x axis marks. Options are 0, 0.5 and 1. The default value at 0is 

especially useful when xAngle = 90. 

yLabel y axis label. Type with quotation marks. Default is NULL. 

yTickLblSize Font size of y axis ticks. Default is 10. 

yTickItalic Set y axis tick font to italic. Default is FALSE. 

legendTtl Hide/Display legend title. If TRUE or T, the name of the first column of the raw data file will 

display as the legend title. Default is FALSE. 

plotWidth The width of the plot (unit: mm). Default is 170. Default will fit most of the cases. 

plotHeight The height of the plot (unit: mm). Default is 150. Default will fit most of the cases. 

y_custom_tick_range To initiate setting the 
custom y_upper_limit, y_lower_limit,y_major_tick_range, y_n_minor_ticks. 

Default is FALSE. 

y_lower_limit Can only be set when y_custom_tick_range = TRUE. Set custom lower limt for y axis. 

Default is 0. Value can be obtained from autorange_bar_y. 

y_upper_limit Can only be set when y_custom_tick_range = TRUE. Set custom upper limt for y axis. 

Value can be obtained from autorange_bar_y. 

y_major_tick_range Can only be set when y_custom_tick_range = TRUE. Set custom major tick range for 

y axis. Value can be obtained from autorange_bar_y. 

y_n_minor_ticks Can only be set when y_custom_tick_range = TRUE. Set custom numbers of minor 

ticks. Default is 4. Value can be obtained from autorange_bar_y. 

 

http://kenstoreylab.com/?page_id=2448
http://127.0.0.1:42384/help/library/RBioplot/help/autorange_bar_y
http://127.0.0.1:42384/help/library/RBioplot/help/autorange_bar_y
http://127.0.0.1:42384/help/library/RBioplot/help/autorange_bar_y
http://127.0.0.1:42384/help/library/RBioplot/help/autorange_bar_y


B. Heatmap: (rbioplot_heatmap) 
The rbioplot_heatmap function can be used to analyze and graph largescale high-throughput studies 
such as large explorations of microRNA differential expression. rbioplot_heatmap is a function for 
plotting simple heatmaps based on the statistical analysis of your choice. Before starting visit the 
rbioplot_heatmap help page, this will outline the different functions and arguments and how to 
properly use them. You can also use the rbioplot_heatmap mini-HELP! box on page 10, for a quick 
reference. 
 
1) The table below is my Sample miRNAs.csv file, the values are standardized miRNA relative abundance 

levels (obtained from qRT-PCR and normalized to the reference gene). The A1 cell should contain 
the word microRNA (or whatever you are measuring). The values I report are an average of the 
relative miRNA abundance for all my technical replicates that correspond to each of my biological 
replicates. This is just a small portion of the file- the full file contains 152 microRNAs.  

 

 
 
2) To generate a heatmap run the following rbioplot command:  

RBioplot::rbioplot_heatmap("Sample microRNAs.csv", Tp = "Dunnett", rmCntl = FALSE, Title = NULL, 
fontType = "sans", tileLow = "firebrick1", tileHigh = "green2", tileLbl = TRUE, tileLblSize = 5, 
tileTxtColour = "white", tileLblPos = 0.5, xLabel = NULL, xTickLblSize = 10, xTickItalic = FALSE, xAngle 
= 0, xAlign = 0.5, yLabel = NULL, yTickLblSize = 10, yTickItalic = FALSE, legendTtl = FALSE, legendPos 
= "right", plotWidth = 170, plotHeight = 600) 

 
3) The above command is very versatile and should be tailored to your specific dataset. You can also 

easily change the colour scheme of your heatmap, refer to V. RBioplot Resources for the full colour 
palette available on with R. For more information on how to customize the arguments go to the 
help page or the mini-help box.  

 
  



4) The above rbioplot_heatmap command outputs a .plot.csv file with detailed metrics for the plot, 
including normalized mean and significance labels, as well as a plot image file (.pdf), with 600 dpi 
resolution.  

 

 
 
 
 
  



 
rbioplot_heatmap   mini-HELP! 
Usage 
rbioplot_heatmap(fileName, Tp = "Dunnett", rmCntl = FALSE, Title = NULL, 

  fontType = "sans", tileLow = "skyblue", tileHigh = "midnightblue", 

  tileLbl = TRUE, tileLblSize = 10, tileTxtColour = "white", 

  tileLblPos = 0.5, xLabel = NULL, xTickLblSize = 10, 

  xTickItalic = FALSE, xAngle = 0, xAlign = 0.5, yLabel = NULL, 

  yTickLblSize = 10, yTickItalic = FALSE, legendTtl = FALSE, 

  legendPos = "bottom", plotWidth = 170, plotHeight = 150) 

Arguments 

fileName Input file name. Case sensitive and be sure to type with quotation marks. Currently only 
takes .csv files. 

Tp Type of the intended statistical test. Case sensitive and be sure to type with quotation 
marks. Options are: "t-test", "Tukey" and "Dunnett". Default is "Dunnett". 

rmCntl Remove the first column (i.e., control). Default is FALSE. 

Title The displayed title on top of the plot. Be sure to type with quotation marks. Default is NULL. 

fontType The type of font in the figure. Default is "sans". For all options please refer to R font table, 
which is avaiable on the website:http://kenstoreylab.com/?page_id=2448. 

tileLow Set the colour for the lower limit of the heatmap. Default is skyblue. For full colour options 

and names, refer to the websitehttp://kenstoreylab.com/?page_id=2448. 

tileHigh Set the colour for the upper limit of the heatmap. Default ismidnightblue. For full colour 

options and names, refer to the website http://kenstoreylab.com/?page_id=2448. 

tileLbl Enable or disable significant notation on the tiles. Default is TRUE. 

tileLblSize Set the font size of the tile label. Default is 10. 

tileTxtColour Set the colour of the on tile label. Default is "white". For full colour options and names, 

refer to the website http://kenstoreylab.com/?page_id=2448. 

tileLblPos Set the position of the tile lables. Options are 0, 0.5 and 1. Default is 0.5. 

xLabel x axis label. Type with quotation marks. Default is NULL. 

xTickLblSize Font size of x axis ticks. Default is 10. 

xTickItalic Set x axis tick font to italic. Default is FALSE. 

xAngle The rotation angle (degrees) of the x axis marks. Default is 0 - horizontal. 

xAlign The alignment type of the x axis marks. Options are 0, 0.5 and 1. The default value at 0 is 

especially useful when xAngle = 90. 

yLabel y axis label. Type with quotation marks. Default is NULL. 

yTickLblSize Font size of y axis ticks. Default is 10. 

yTickItalic Set y axis tick font to italic. Default is FALSE. 

legendTtl Hide/Display legend title. Default is FALSE. 

legendPos Set the legend position. Options are "top", "bottom", "left"and "right". Default 

is "bottom". 

plotWidth The width of the plot (unit: mm). Default is 170. Default will fit most of the cases. 

plotHeight The height of the plot (unit: mm). Default is 150. Default will fit most of the cases. 

y_custom_tick_range To initiate setting the 
custom y_upper_limit, y_lower_limit,y_major_tick_range, y_n_minor_ticks. 

Default is FALSE. 

y_upper_limit Can only be set when y_custom_tick_range = TRUE. Set custom upper limt for y axis. 

Value can be obtained fromautorange_bar_y. 

y_lower_limit Can only be set when y_custom_tick_range = TRUE. Set custom lower limt for y axis. 

Default is 0. Value can be obtained fromautorange_bar_y. 

y_major_tick_range Can only be set when y_custom_tick_range = TRUE. Set custom major tick range for 

y axis. Value can be obtained fromautorange_bar_y. 

y_n_minor_ticks Can only be set when y_custom_tick_range = TRUE. Set custom numbers of minor 

ticks. Default is 4. Value can be obtained from autorange_bar_y. 

 

http://kenstoreylab.com/?page_id=2448
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C. Joint-point curve: (rbioplot_curve) 
rbioplot_curve is a simple to use function for plotting joining-point curve figures with continuous X-axis 
and Y-axis values. Before starting visit the rbioplot_curve help page, this will outline the different 
functions and arguments and how to properly use them. You can also use the rbioplot_curve mini-
HELP! box on page 12. 
 
1) In this example below I plotted my imaginary enzyme’s activity for 18 eluted fractions from both 

control and 24 h frozen. I used the Sample Elution Profile.csv (below). The independent variables 
are listed in column A.  

 
2) To generate a histogram run the following rbioplot command:  

RBioplot::rbioplot_curve("Sample Elution Profile.csv", Title = NULL, 
errorbar = "SEM", errorbarWidth = 0.2, fontType = "sans", symbolSize = 2, 
xLabel = "Fraction", xTickLblSize = 10, xTickItalic = FALSE, xAngle = 0, 
xAlign = 0.5, yLabel = "Relative Activity", yTickLblSize = 10, yTickItalic 
= FALSE, legendTtl = FALSE, plotWidth = 170, plotHeight = 150, 
x_custom_tick_range = TRUE, x_lower_limit = 5, x_upper_limit = 23, 
x_major_tick_range = 1, x_n_minor_ticks = 0, y_custom_tick_range = TRUE, 
y_lower_limit = -0.2, y_upper_limit = 1.2, y_major_tick_range = 0.2, 
y_n_minor_ticks = 4) 

 
3) The above rbioplot_curve command outputs a .plot.csv file with 

detailed metrics for the plot, including Mean and SEM, as well as 
a plot image file (.pdf), with 600 dpi resolution. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  
rbioplot_curve   mini-HELP! 
Usage 
rbioplot_curve(fileName, Title = NULL, errorbar = "SEM", 

  errorbarWidth = 0.2, fontType = "sans", symbolSize = 2, xLabel = NULL, 

  xTickLblSize = 10, xTickItalic = FALSE, xAngle = 0, xAlign = 0.5, 

  yLabel = NULL, yTickLblSize = 10, yTickItalic = FALSE, 

  legendTtl = FALSE, plotWidth = 170, plotHeight = 150, 

  x_custom_tick_range = FALSE, x_lower_limit = 0, x_upper_limit, 

  x_major_tick_range, x_n_minor_ticks = 0, y_custom_tick_range = FALSE, 

  y_lower_limit = 0, y_upper_limit, y_major_tick_range, y_n_minor_ticks = 4) 

 

Arguments 
fileName Input file name. Case sensitive and be sure to type with quotation marks. Currently only 

takes .csv files. Note that the column names (excluding the first column) need to be numeric. 

Title The displayed title on top of the plot. Be sure to type with quotation marks. Default is NULL. 

errorbar Set the type of errorbar. Options are standard error of mean ("SEM"), or standard deviation ("SD"). 

Default is "SEM". 

errorbarWidth Set the width for errorbar. Default is 0.2. 

fontType The type of font in the figure. Default is "sans". For all options please refer to R font table, which is 
avaiable on the website:http://kenstoreylab.com/?page_id=2448. 

symbolSize Set the size of symbols. Default is 2. 

xLabel x axis label. Type with quotation marks. Default is NULL. 

xTickLblSize Font size of x axis ticks. Default is 10. 

xTickItalic Set x axis tick font to italic. Default is FALSE. 

xAngle The rotation angle (degrees) of the x axis marks. Default is 0 - horizontal. 

xAlign The alignment type of the x axis marks. Options are 0, 0.5 and 1. The default value at 0 is especially 

useful when xAngle = 90. 

yLabel y axis label. Type with quotation marks. Default is NULL. 

yTickLblSize Font size of y axis ticks. Default is 10. 

yTickItalic Set y axis tick font to italic. Default is FALSE. 

legendTtl Hide/Display legend title. If TRUE or T, the name of the first column of the raw data file will display as 

the legend title. Default is FALSE. 

plotWidth The width of the plot (unit: mm). Default is 170. Default will fit most of the cases. 

plotHeight The height of the plot (unit: mm). Default is 150. Default will fit most of the cases. 

x_custom_tick_range To initiate setting the 
custom x_upper_limit, x_lower_limit,x_major_tick_range, x_n_minor_ticks. Default 

is FALSE. 

x_lower_limit Can only be set when x_custom_tick_range = TRUE. Set custom lower limt for x axis. Default 

is 0. Value can be obtained fromautorange_curve. 

x_upper_limit Can only be set when x_custom_tick_range = TRUE. Set custom upper limt for x axis. Value can 

be obtained fromautorange_curve. 

x_major_tick_range Can only be set when x_custom_tick_range = TRUE. Set custom major tick range for x axis. 

Value can be obtained fromautorange_curve. 

x_n_minor_ticks Can only be set when x_custom_tick_range = TRUE. Set custom numbers of minor ticks. Default 

is 4. Value can be obtained from autorange_curve. 

y_custom_tick_range To initiate setting the 
custom y_upper_limit, y_lower_limit,y_major_tick_range, y_n_minor_ticks. Default 

is FALSE. 

y_lower_limit Can only be set when y_custom_tick_range = TRUE. Set custom lower limt for y axis. Default 

is 0. Value can be obtained fromautorange_curve. 

y_upper_limit Can only be set when y_custom_tick_range = TRUE. Set custom upper limt for y axis. Value can 

be obtained from autorange_curve. 

y_major_tick_range Can only be set when y_custom_tick_range = TRUE. Set custom major tick range for y axis. 

Value can be obtained fromautorange_curve. 

y_n_minor_ticks Can only be set when y_custom_tick_range = TRUE. Set custom numbers of minor ticks. Default 

is 4. Value can be obtained from autorange_curve. 
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V. RBioplot Resources 
To customize your graphs and make them more visually appealing (or usually you have to make them 

more boring for journals), you can refer to the R colour palette and R font table below.  

 R colour palette                R font table  

      
    
 
 
 
 
 


